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TÓM TẮT 

Phương tiện dạy học nói chung, phương tiện công nghệ thông tin nói riêng là công cụ hết sức quan trọng 

góp phần tăng tính hiệu quả của các phương pháp dạy học, góp phần làm rõ những điều mà người dạy muốn trình 

bày và giúp cho người học dễ hiểu, dễ nhớ và có thể chủ động học tập theo tiến độ. Thực tế đã chứng minh rằng, 

khi được nghe nhìn khả năng ghi nhớ của người học tăng lên 50%, khi đã thao tác với các phương tiện dạy học thì 

kiến thức đó đã là của mình và khả năng ghi nhớ hơn 90%. Phần mềm flash là công cụ giúp người dạy có thể tạo 

ra một số mô hình động. Nếu sử dụng đúng mô hình động trong quá trình dạy học sẽ mang lại hiệu cao, đặc biệt là 

học phần Trái Đất. 

Từ khóa: Phương tiện dạy học; phương pháp dạy học; quá trình dạy học; tính hiệu quả; khả năng ghi nhớ. 

ABSTRACT 

Teaching tools, especially information technology tools, could be used to enhance the efficiency of teaching 

methods, helping to clarify the content which teachers want to present and make it easier for students to understand, 

memorize and actively follow their learning progress. It has been proved that visualization could improve 

memorization ability up to 50%; furthermore, if students interact with teaching tools by themselves so that they can 

master the knowledge, and then their memorization ability could increase further to more than 90%. Flash software is 

the tool that can be utilized in designing moving pictures. If these moving pictures are used properly, they will bring 

high teaching efficiency, especially in the course on “earth science”. 

Key words: teaching tools; teaching methods; teaching process; efficiency; memorization ability. 

 

1. Đặt vấn đề 

Công nghệ thông tin ngày càng ảnh hưởng 

sâu sắc tới giáo dục và đào tạo trên nhiều khía 

cạnh khác nhau, trong đó có dạy học. Nhiều sự vật 

và hiện tượng địa lí có không gian rất rộng lớn, 

tiến trình lâu dài. Để hiểu nó một cách sâu sắc, các 

phương tiện dạy học có một chức năng vô cùng to 

lớn, ngoài chức năng minh họa, điều quan trọng 

nhất trong đổi mới phương pháp dạy học hiện nay 

đó là chức năng nguồn tri thức. Việc xây dựng và 

đưa vào các bài giảng điện tử, các công cụ hỗ trợ 

như âm thanh, hình ảnh, video… đặc biệt là các 

mô hình động càng làm cho việc dạy học Địa lí 

thêm phần trực quan, đáp ứng được yêu đổi mới 

phương pháp dạy học hiện nay.  

2. Nội dung 

2.1. Xây dựng mô hình động địa lí bằng phần 

mềm Macromedia Flash 

2.1.1. Khái niệm mô hình - mô hình động địa lý 

- Khái niệm mô hình 

Mô hình được hiểu là “vật cùng hình dạng 

nhưng làm thu nhỏ lại nhiều, mô phỏng cấu tạo và 

hoạt động của một vật thể khác để trình bày, 

nghiên cứu hoặc là hình thức diễn đạt hết sức ngắn 

gọn theo một ngôn ngữ nào đó các đặc trưng chủ 

yếu của một đối tượng, để nghiên cứu đối tượng 

ấy” [4, tr.27]. Mô hình có tính đồng nhất hoặc 

tương đồng với cấu trúc của đối tượng được mô tả. 

Mô hình trên máy tính là sự mô phỏng, sắp 

xếp các đối tượng, sự vật theo một trật tự nhất định 

nào đó tùy thuộc vào ý đồ mà người xây dựng mô 
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hình đó đưa ra. Mô hình trên máy tính được xây 

dựng bằng các phần mềm khác nhau tùy theo yêu 

cầu và tính chất phức tạp hay đơn giản của nó.  

- Mô hình động 

Mô hình động (Dynamic model) là sự mô 

hình hóa hoạt động thật sự của sự vật hiện tượng hay 

một hệ thống và trình bày một hướng nhìn đối với 

một hệ thống, trong thời gian hệ thống hoạt động.  

- Mô hình động địa lí 

Trong Địa lí các mô hình động thường được 

dùng để phản ánh cấu tạo, hoạt động, khái quát và 

giúp hình dung được cấu trúc không gian tuy đã 

được phóng to lên hoặc thu nhỏ lại so với kích 

thước thật. Chẳng hạn như mô hình chuyển động 

của các hành tinh trong hệ Mặt Trời, mô hình 

chuyển động của dòng biển… 

Mô hình động nói chung và mô hình động 

địa lí nói riêng được xây dựng dựa trên nguyên 

mẫu các mô hình tĩnh.  

2.1.2. Các nội dung học phần Trái Đất có thể xây 

dựng mô hình động để dạy học  

 

Bảng 1. Các nội dung có thể xây dựng mô hình động 

Nội dung Mô hình 

Chương 2: Vũ trụ và hệ Mặt Trời - Sự hình thành hệ Mặt Trời 

- Hệ Mặt Trời 

Chương 3: Đặc điểm của Trái Đất - Chuyển động của các mảng thạch quyển 

- Các cách tiếp xúc của các mảng thạch quyển 

Chương 4: Những vận động chính của 

Trái Đất 

- Sự chuyển động lệch hướng của các vật thể 

- Sự chuyển động biểu kiến hàng năm của Mặt Trời 

- Sự chuyển động Trái Đất quanh Mặt Trời 

- Tuần Trăng 

- Giải thích hiện tượng thủy triều 

- Sự chênh lệch triều trong tuần Trăng 
 

2.1.3. Phần mềm Macromedia Flash và xây dựng 

mô hình động bằng Flash 

a) Ý nghĩa của phần mềm 

Macromedia Flash là phần mềm vẽ hình cho 

phép tạo hình ảnh động, có các hiệu ứng chuyển 

động và biến đổi, lập trình để tạo ra các hoạt động 

mô phỏng và tương tác một cách sinh động, hấp 

dẫn .Với phần mềm Macromida Flash, chúng ta có 

thể thiết lập qui trình hình thành, quá trình diễn 

biến một số quá trình và hiện tượng địa lí xảy ra 

trong tự nhiên. 

b) Xây dựng mô hình động địa lý bằng 

phần mềm Macromedia Flash  

Để tiến hành xây dựng mô hình động Địa lí 

trên phần mềm Macromedia Flash cần chuẩn bị đầy 

đủ nguồn tài liệu, gồm 2 loại chủ yếu là tài liệu địa 

lí và tài liệu về phần mềm Macromedia Flash. 

c) Quy trình và kĩ thuật xây dựng 

- Xác định nội dung cần xây dựng 

Các nội dung kiến thức cần thể hiện trong 

mô hình, xây dựng kịch bản cho mô hình 

- Đưa nội dung cần xây dựng vào 

Macromedia Flash 

Sau khi đã chuẩn bị đầy đủ nội dung cần 

xây dựng bước tiếp theo là đưa các nội dung đó 

vào trong phần mềm Macromedia Flash. Hay nói 

cách khác là multimedia hóa kiến thức liên quan 

đến mô hình động cần xây dựng. Tùy từng dạng 

tài liệu chứa đựng kiến thức mà hình thức đưa vào 

có sự khác nhau. 
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- Đối với tài liệu kiến thức dạng ảnh 

(image) hoặc phim (video) thực hiện như sau: Sau 

khi khởi động phần mềm vào File/Import. Chọn 

vào Import to Stage nếu muốn đưa trực tiếp ảnh 

vào vùng làm việc. Còn nếu muốn đưa ảnh vào thư 

viện của chương trình để sử dụng sau thì chọn vào 

Import to Library. Chọn Import Video nếu như 

muốn đưa một đoạn phim vào chương trình. 

- Đối với tài liệu dạng chữ (text) có thể gõ 

trực tiếp vào chương trình bằng công cụ Text Tool 

(T) hoặc sao chép từ các phần mềm soạn thảo văn 

bản qua. 

2.1.4. Xây dựng một số mô hình của học phần Trái Đất 

a) Mô hình sơ đồ chênh lệch thủy triều 

theo tuần trăng 

- Kiến thức liên quan: 

+ Thủy triều là hiện tượng mực nước biển 

và đại dương dao động theo những chu kỳ và biên 

độ nhất định. 

+ Nguyên nhân tạo ra thủy triều là do lực hấp 

dẫn của Mặt Trăng và Mặt Trời đối với Trái Đất. 

+ Trái Đất chuyển động quanh Mặt Trời, 

Mặt Trăng chuyển động quanh Trái Đất, tùy vị trí 

Trăng trên quỹ đạo, thủy triều trên Trái Đất sẽ xảy 

ra khác nhau: 

• Khi Mặt Trăng, Mặt Trời và Trái Đất cùng 

nằm trên một đường thẳng (khô Trăng Trăng tròn), 

lực tạo triều là tổng hợp của Mặt Trăng và Mặt 

Trời nên đạt giá trị lớn nhất trong tháng Âm –

Dương lịch. 

• Khi 3 thiên thể ở vị trí vuông góc (Trăng 

bán nguyệt), thủy triều là hiệu của hai lực nên dao 

động nhỏ. 

- Quy trình thiết kế: 

 Mô hình này thể hiện sự dao động thủy 

triều trong tháng Âm - Dương lịch giúp người học 

có thể hiểu rõ hơn về hiện tượng. Các bước thực 

hiện như sau:  

 + Khởi động Flash 8. 

 + Chọn Creat New → Flash Document để 

mở giao diện thiết kế mô phỏng như hình sau: 

 

  
 

+ Trên Layer 1 dùng công cụ Oval Tool để 

vẽ hình Mặt Trời: 

 

+ Sử dụng vùng Color Mixer để phối màu 

cho Mặt Trời: 
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 + Vẽ lực tác động (Lực hấp dẫn của Mặt 

Trời), trên giao diện thiết kế click biểu tượng 

Insert layer.  

  
 

 + Trên Layer 2 sử dụng công cụ Line Tool 

để vẽ mũi tên chỉ hướng tác động của Mặt Trời 

 + Tạo chuyển động cho mũi tên: Trên 

Timeline của Layer 2 chọn vị trí 

(20:21:40:41:60:61:80) chèn Keyframe (Right 

click→ Insert Keyframe hoặc nhấn phím F6). Tại 

các vị trí (20:40:60:80) sử dụng công cụ Selection 

Tool để di chuyển hình vẽ mũi tên về phía trước. 

Tiếp theo trên thanh Timeline của Layer 2 →Right 

click giữa các Keyframe → Chọn Create Motion 

Tween để tạo ra chuyển động của mũi tên 

 

 + Vẽ hình Trái Đất: Sử dụng công cụ Oval 

Tool và dùng Color Mixer để tạo hình vẽ tượng 

trưng cho Trái Đất trên Layer 3. 

 

 + Trên Layer 4 vẽ hình Mặt Trăng: 

Chọn Insert Layer (Tạo Layer 4) → Oval 

Tool (Stroke color –None; Fill color chọn màu cho 

hình vẽ Mặt Trăng) 
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 + Thiết kế quỹ đạo chuyển động cho Mặt 

Trăng: Trên thanh Timeline chọn Add Motion 

Guide, sử dụng công cụ Oval Tool để vẽ quỹ đạo 

chuyển động cho Mặt Trăng. 

 + Trên Layer 4 tại các vị trí (20:40:60:80) 

chọn Insert Keyframe, sử dụng công cụ Select 

Tool để dịch chuyển hình vẽ Mặt Trăng đến các vị 

trí trên quỹ đạo. Giữa các vị trí Keyframe → Right 

Cick→ Create Motion Tween. 

 

 

      

  

 

+ Vẽ mũi tên thể hiện lực hút của Mặt Trăng 

trên Layer mới. Chọn Insert Layer→ Layer 6, sử 

dụng công cụ Line Tool để vẽ hình mũi tên. Lực 

hút của Mặt Trăng sẽ xoay hướng về Mặt Trăng → 

Insert Keyframe trên Layer này tương ứng với các 

vị trí trên Layer4 → Sử dụng công cụ Free 

Transform Tool xoay mũi tên hướng về vị trí Mặt 

Trăng. Giữa các Keyframe vừa tạo Right Click → 

Create Motion Tween. 
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 + Hình ảnh lớp nước trên bề mặt Trái Đất 

thay đổi được tạo trên Layer mới. Insert Layer 

→Layer 7 → Oval Tool để vẽ hình nước trên bề 

mặt Trái Đất. Insert Keyframe tại các vị trí tương 

tự như trên Layer 4, tại các vị trí (20:60) sử dụng 

công cụ Free Transform Tool để kéo dãn (Chỉnh 

thành hình tròn) hình vẽ lớp nước. Tạo Create 

Motion Tween tương tự như trên Layer 6. 

 

  

 

 



UED JOURNAL OF SOCIAL SCIENCES, HUMANITIES AND EDUCATION                                   VOL.4, NO.2 (2014) 

81 

 + Sau khi hoàn thành phần hoạt cảnh, ta tạo 

các nút dừng (Pause) và chạy (Play) cho mô phỏng 

trên: Menu Window → Common libraries → 

Buttons. 

 

 + Insert Layer →Layer, click và kéo thả các 

button flat blue play, flat blue stop vào giao diện 

thiết kế Layer 8. Tạo text PLAY và PAUSE dưới 

các button. 

 

 + Viết code cho các button :  

Chọn button PAUSE→ Actions-button: on 

(release) {stop();}” 

 

 + Chọn button PLAY →Actions-button:on 

(release) {play();} 

 

 + Nhấn Ctrl + Enter để xem giao diện thiết 

kế hoàn chỉnh. 

 

 

b) Sơ đồ chuyển động biểu kiến của Mặt 

Trời 

- Kiến thức liên quan: 

Hiện tượng Mặt Trời ở đúng đỉnh đầu lúc 12 

giờ trưa được gọi là Mặt Trời lên thiên đỉnh.Ở Trái 

Đất, hiện tượng này chỉ lần lượt xảy ra tại các địa 

điểm từ xích đạo (ngày 21/3) cho tới 23027’B 

(ngày 22/6) rồi lại về xích đạo ngày 23/9, xuống vĩ 

tuyến 23027’N (22/12). Điều này làm ta có ảo giác 

Mặt Trời di chuyển. Nhưng trong thực tế không 

phải Mặt Trời di chuyển mà là Trái Đất chuyển 

động tịnh tiến xung quanh Mặt Trời. Chuyển động 

không có thực đó của Mặt Trời được gọi là chuyển 

động biểu kiến hằng năm của Mặt Trời. 

- Quy trình thiết kế: 

Mô hình này biểu hiện sự chuyển động của 

biểu tượng Mặt Trời trên sơ đồ. Nhằm giúp sinh 

viên hình dung về hiện tượng một cách dễ dàng 

hơn. Đến mỗi điểm ở xích đạo vào ngày 21/3, lên 

chí tuyến bắc vào ngày 22/6, quay trở về xích đạo 

ngày 23/9 và xuống chí tuyến nam ngày 22/12 biểu 

tượng sẽ dừng lại. Khi muốn cho biểu tượng chạy 

tiếp chỉ cần nhấp chuột vào nút tương ứng ở dưới. 

Các bước thực hiện mô hình như sau: 
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+ Khởi động Flash: chọn Creat New → 

Flash Document để mở một trang làm việc mới. 

+ Tạo mô hình Trái Đất 

- Từ layer mới tạo thành, nháy đúp chuột 

vào tên Layer 1 và đổi tên thành Trái Đất  

. 

- Dùng công cụ oval Tool  để vẽ mô 

hình của Trái Đất; dùng công cụ Line Tool (N) 

 để vẽ đường Xích đạo, chí tuyến Nam, chí 

tuyến Bắc và hình Trái Đất, kết quả như sau: 

 

- Tạo thêm 1 Layer mới có tên là chú thích 

để mô tả các nội dung trên 

 

- Tạo thêm 1 Layer mới có tên là mặt trời để 

vẽ mô hình mặt trời. Kết quả như sau: 

 

 

- Tạo đường dẫn để mô tả hoạt động biểu 

kiến. Nhấp chọn nút Add Motion Guide  để 

chèn thêm một lớp mới có tên là đường dẫn, kết 

quả như sau: 

 

- Tạo chuyển động biểu kiến của Mặt Trời: 

Từ layer mặt trời, chúng ta nhấp phải và chọn 

 để mô tả hoạt động biểu kiến. 

- Tạo các điều kiển hoạt động chuyển động 

biểu kiến của Mặt Trời: chúng ta vào 

Window/common libraries/buttons. Hộp thoại 

Library - Buttons xuất hiện 

 

Chúng ta nhấp chọn  để 

thể hiện nút dừng và chọn  để thể 

hiện nút chạy. Kết quả như sau:  

- Viết mã lệnh cho các frame và nút 

- Chọn frame 1 của layer “vat”, nhấn F9, 

nhập stop(); làm tương tự cho frame cuối cùng.  
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- Chọn nút “Play” nhấn F9 và nhập đoạn mã 

sau on(release){play();} 

 

- Chọn nút “Stop” nhấn F9 và nhập đoạn mã 

sau on(release){stop();} 

 

- Chọn nút Play của frame cuối cùng, nhấn 

F9 và nhập đoạn mã sau on(release) 

{gotoAndPlay(2);} 

 

2.2. Sử dụng các mô hình động trong dạy học 

Các mô hình động được sử dụng chủ yếu 

trong quá trình giảng bài trên lớp. Với tính chất là 

phương tiện trực quan, trong quá trình dạy học, 

người dạy sử dụng các mô hình với hai chức năng: 

minh họa các đối tượng địa lí cần đề cập đến, với 

quan điểm đổi mới dạy học hiện nay, các mô hình 

được sử dụng với chức năng nguồn tri thức. Muốn 

sử dụng nó theo chức năng gì, việc đầu tiên người 

dạy phải xác định được mục tiêu của nội dung cần 

đạt của người học là gì để có những định hướng sử 

dụng có hiệu quả.  

Ví dụ 1: 

Khi dạy về đặc điểm hệ Mặt Trời, mục tiêu 

của nội dung này người học hiểu được hệ Mặt Trời 

là gì? Đặc điểm của các hành tinh trong hệ Mặt 

Trời. Người dạy có thể sử dụng mô hình hệ Mặt 

Trời như sau: 

- Đầu tiên chiếu mô hình tĩnh về hệ Mặt 

Trời, yêu cầu người học xác định tên mô hình, từ 

đó hiểu được khái niệm hệ Mặt Trời 

- Tiếp theo đưa ra các câu hỏi định hướng 

khai thác kiến thức như: thứ tự các hành tinh của 

hệ Mặt Trời, đặc điểm chuyển động quanh trục và 

quanh Mặt Trời của các hành tinh, nhận xét số 

lượng vệ tinh của các hành tinh,… sau đó làm cho 

các đối tượng chuyển động, yêu cầu người học 

quan sát để trả lời câu hỏi đã được định hướng. 

Ví dụ 2: 

Khi dạy phần hệ quả địa lí của sự vận động 

hệ thống Trái Đất – Mặt Trăng. Nội dung này có 

mục tiêu đó là người học giải thích được tại sao 

trên Trái Đất có hiện tượng sóng triều, thủy triều 

thay đổi như thế nào trong tuần trăng. Để dạy nội 

dung này người dạy sử dụng 2 mô hình: 

- Mô hình giải thích hiện tượng thủy triều, 

mô hình này người dạy sử dụng với chức năng 

minh họa kiến thức đã giảng giải, sau khi giảng 

xong chiếu hình để minh họa. 

- Mô hình sự thay đổi độ lớn triều trong tuần 

trăng lại được sử dụng với chức năng là nguồn tri 

thức. Trước khi chiếu hình người dạy đưa ra các 

câu hỏi định hướng trước, yêu cầu người học quan 

sát sự chuyển động của các đối tượng trong mô 

hình để biết được ngày nào trong tháng âm lịch 

triều lớn nhất, bé nhất và vì sao? 

3. Kết luận 

Học phần Trái Đất có đối tượng là những sự 

vật và hiện tượng địa lí xảy ra trong không gian và 
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trên bề mặt Trái Đất, các hiện tượng đó có phạm vi 

không gian rộng lớn, có quá trình diễn biến phức 

tạp và lâu dài. Mô hình động là một trong những 

phương tiện dạy học hữu hiệu của người giảng 

viên Địa lí. Việc đưa các mô hình động vào bài 

giảng làm cho người học dễ dàng hơn trong việc 

hình dung các sự vật, hiện tượng địa lí diễn ra 

trong tự nhiên, điều này sẽ giúp người học nhận 

biết các sự vật và hiện tượng một cách sinh động, 

chính xác, đầy đủ. Tạo sự hứng thú và niềm tin 

trong hoạt động nhận thức của người học, người 

dạy có nhiều điều kiện thuận lợi hơn trong việc đổi 

mới phương pháp dạy học.  
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